QUICK AND DIRTY FINALCUT PRO INSTRUCTION SHEET

Step One: Set Up a Folder on the Deskiop
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Your entire video project will go in here. The folder eventually will be huge: Trneedsto—

be on the desktop and all project elements need to go in it so you can move it easily to the
instructor’s hard drive for storage. While it’s fine to store video files from the Handycam
on the institute’s shared folder, you may not store FinalCut projects there because they
are big enough to clog the school’s servers. FinalCut projects stored in the institute’s
shared folder will be deleted without warning.

Step Two: Drag AVCHD Folder From Handycam or Institute Shared Folder Into
the Folder You Created

See the handout Using Sony Handycams and Getting Video Into FinalCut.
Step Three: Start FinalCut

Click this icon in the task bar.

Step Three: Drag AVCHD Folder From Handycam or Institute Shared Folder Into
The Folder You Created

~ See the handout Using Sony Handycams and Getting Video Into FinalCut.



Step Four: Set Scratch FinalCut Scratch Disks to Your Folder .

Each time you start FinalCut, you will get the prompt below asking you to set the scratch
disks, which is where all of the files associated with a FinalCut project go. It asks because
video projects are big enough to choke hard drives, and it’s usually a good idea to have
an external hard drive to hold video projects so as to avoid clogging your computer. Hit
Reset Scratch Disks.

At the prompt below, you need to click “Set” and then select you’re the desktop folder
you created for four items in this prompt: the top item, which directs the overall project
someplace (don’t mess with the boxes that have checks); Waveform Cache; Thumbnail
Cache and Autosave Cache. Hit OK.
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Step Five: Create a Project in Final Cut (File>New Project)

It’s a good idea to save the project right away so FinalCut’s autosave function can start
protecting you. Be sure to save the project in the desktop folder you created!

New
New Project 38N
Open... %0
Open Recent >




Step Six: Hit File>Log and Transfer to Import Video Folder

See the handout Using Sony Handycams and Getting Video Into FinalCut.

~ Step Seven: Get to Know the FinalCut Work Area

Don’t worry. It looks complicated, but it makes sense once you go through it once or
twice. You can do very sophisticated things in FinalCut, but you need to know very little
to produce a simple video.

The sections of the FinalCut screen are:

* The Browser (upper left): This is where your clips from the camera and any
photos, music, etc., you want in the project (File>Import) show up. All you need
to know about the Sequence 1 you see at this point is that it represents what’s in
the timeline (explained below).

» Viewer (top middle): The magic happens here. Double click the icon next to an
item in the browser and it will load here. You’ll use the viewer to define
selections from clips that you want to go into the movie. See below for details.

» Canvas (top right): This is a player that shows what you’ve put in your timeline.
You can do some fancier things here, but this is a beginner class so don’t worry
about those.

 Timeline: You’ll arrange video and audio here to make the movie. The video
track goes on top and the audio track goes below. FinalCut has multiple video and
audio tracks, which provides a lot of flexibility in creating projects. More on that
in a bit.

Viewer: You look at clips Canvas: This window
here and decide what ‘ B plays what's in your
will go in your timeline, timeline,

. (see above) go here,

o

Timeline: Video tracks go in this
section.

Timeline: Audio tracks go in this
section (almost always associated |
with video tracks)




Step Eight: Review What’s in Your Browser e

Your clips will be labeled Clip #1, etc., which is almost useless, though the duration of
clips can give you some idea of what’s an interview and what’s B-roll. It might help to

review and name each clip (click the icon left of the hame and play the clip i th
viewer). But it isn’t worth it with a small project. However ...

Without reviewing each clip, you can get a good idea of what’s in them by changing the
view to icons (View>Browser Items>As medium icons).

Step Nine: Let’s Define a Clip .

Double click on the icon next to (or over) the name of the clip to load that clip in the
Viewer (top middle). This is where you will define what from that clip you want in your
movie. There are a lot of options in here, but all you need to know at this point is that the
white line immediately below the clip has a playhead (yellow triangle) that shows where
you’re at in the clip (you can “scrub” through the clip quickly by dragging the playhead
and dragging it right and left). There’s a start/stop button where you’d expect it, and you
might find the go to the start/go to the end buttons helpful. Turn the scroll wheel right and
left to move very slowly through the clip (very helpful when finding the precise point in
interviews where you want the passage to begin and end).

Go Begmman End

Scrol

Playhead Start/Stop slowly
[}
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Step 10: Set In and Out Points in Your Clip

When you identify the point where you want the clip to begin, hit the I key to set an “in”
point. You’ll see a symbol that looks like this >|. When you identify the point where you

want the clip to end, hit the O key to set an “out” point. You will see a symbol that Tooks
like this |<. '

Step 11: Put Your Clip in the Timeline

The timeline (bottom of the screen) has its own playhead. Put the playhead where you
want your clip to appear. You then have two options for getting the clip from the browser
into the timeline: drag it directly into the timeline or drag it into the Canvas window,
where you will see a series of options. Click and hold in the browser and you’ll see that
the mouse has “grabbed” the clip. I recommend dragging the clip directly into the
timeline.

You have two main options when you put a clip into the timeline: the Insert and
Overwrite options, If dragging your clip into the timeline, you’ll see an arrow pointing
either to the right (insert) or down (overwrite). If you use the Insert option, the clip will
break into anything that’s already at that point in the timeline and push everything from
the playhead forward to the right. The overwrite option is more forgiving. Let go of the
mouse button and the clip will be in the timeline. You can move it around with the mouse
once it’s there.

If you see this prompt, just say yes.

I5 does pot match this sequence’s seirings or
nce presets,




Here’s what the timeline should look like with a clip in it. The video portion of the file is
above, and there are two audio tracks below. The video and audio tracks are connected. '
You can work with them independently, but that’s beyond where we’re at.

You can keep adding clips to the right of the one that’s there. The new clip should snap to
the existing one when you’re in the right spot.

b3 e S e LA AT O 5

Step 12: Play Your Timeline in the Canvas Window (top right) o
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Put the playhead at the beginning of the timeline and see what you’ve created.
Step 13: Practice Adding a Cutaway Shot

Cutaway shots, or B-roll, can be added very easily in FinalCut because it offers a
seemingly limitless number of video tracks (V1, V2, V3, etc.). Any clip that’s in a video
track above a clip in another video track will play over the video clip below. A cutaway
shot shouldn’t be more than 3-4 seconds. Count one off in the browser and drag it to the
timeline and use the OVERWRITE option to put it in track V2 above a track in V1. You
will see the clip in the V2 track and in audio tracks below the audio associated with the
clip in V1. You move the cutaway shot right and left to get it exactly where you want it.
You can add more cutaway shots the same way. Play what’s in the timeline and yow’ll
see the cutaway shot play over what was there before.

o




Step 14: Adjust the Volume

Any audio tracks in the timeline at the same point will play. With audio associated with
cutaway shots/B-roll, it’s best to lower the audio level (some of that sound is usually

yow’ll see this display in the Browser window. Use the mouse to grab the top pink line
and move it down (you can also move it up if you want to raise the audio level). Click on
the video tab at the top of the browser and you’ll see the video associated with the audio
when you play the timeline.

Step 15: Render Unto Caesar — Or Just Render

If you see a red line right above the timeline, it means you need to render audio or video
in that section. Just execute Sequence>Render Selection>Both. If that doesn’t make the
red line disappear, ask the instructor.

Render Selection

Render All
Render Only b
Settings... 80

Step 15: Export Your Movie

Just trust me on these steps:

e Conversion (NOT QuickTime Movie).

ﬁ;%g; I

QuickTime Movie...

Using Compressor...

Baich Export . . .
o Using QuickTime Convearsion...

Batch Capture...
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2. When prompted, give the movie a name and a destination where you can find it. Make
sure the format says QuickTime. Then hit the Options button to the right of the Format
dropdown.
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Hit the Size button and select Custom from the Dimensions dropdown.

Current
¥ Compressor native

160% 120

176 x 144 QUIF
320 x 240 QVEA
352 x 288 CIF
E49 x 480 VCA
768 x 576 5D
1250 x 720 HO
1520 x 1080 HD

NTSC 720 x 450 4:3
NTSC 720 x 480 16:9
NTSC 720 x 486 413
NTSC 720 x 486 16:9
PAL 720 x 576 4:3
PAL 720 x 576 16:5
HD 1280 x 720 16:9
HD 1440 x 1080 16:9

HD 1520 x 1980 16:9

L peeserve aspect ratio using: - !

* T Dejarerlace Sourcs Video

Hit the Settings button under Sound and use the dropdown to change the Rate to 44.100

from 48.000. Hit OX.

Hit OK to get out of Movie Settings and then Save your movie to start the process of

creating the QuickTime movie.
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USING SONY HD HANDYCAMS AND GETTING VIDEO INTO FINALCUT

Contents:
a. Take a deep breath
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b Cariera basics (orv/off; video/photos; zoom)
_¢. More involved camera stuff (viewing video, options screen)
d. Getting your video files into the institute’s server folder
e. Getting your video files into FinalCut
Take a Deep Breath

Seriously — I want you to take a deep breath. Close your eyes and find a place of zen.
Envision yourself turning on the camera, pointing it at something or someone you
want to document, hitting the record button and capturing crisp video. Believe it or
not, most video cameras today are this easy to use. This doesn’t make it easier to
choose the right scenes and subjects, frame properly, etc., but it makes things a lot
easier before you do. The camera you will use in this class also has a hard drive,
making exporting video much easier than a camera recording on tape.

Camera Basics

Here is a rough representation of the business end of the Handycam, focusing on the
few features you need to understand to make it work.
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This wheel turns the camcorder off and on.

This button stops and starts recording.

Here’s the viewscreen. Flip it out from the side of the camera.
The battery goes here. It’s secured by a latch underneath.

Direct view into lens. Just forget this exists. Use the viewscreen,
These are various items on the viewscreen that it helps to know.
Zoom lever,

SR el ol Sl



1. Turn the camera on and off:

There’s a wheel around the record button with a small green button on it. To turn the
camera on, depress the button and turn the wheel clockwise (it only goes a bit). The
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viewscreen should activate, and one of two lights just above the wheel will come on.
Make sure the one on the left is on. It’s the one with the movie icon. If you push the

wheel clockwise again, the right light will come on, meaning you’re in photo mode.

Push it clockwise again to get back to movie mode.

2. Record.

Hit the button to record. Hit the button again to stop recording. You create a separate
shot on the camcorder’s hard drive each time you hit record.

3. Viewscreen

The viewscreen should show whatever the camera is pointing at. We’ll get to the
various touchscreen buttons and information below.

4. Battery

The battery should be fine at this point. If ever you need to. remove it, push the latch
at the bottom toward the front of the camera. To re-seat the battery, push the top end
in first and then push the bottom end into the latch. It will snap into place. If it
doesn’t, don’t try forcing it. Ask for help. To preserve the battery life, the camera will
shut of automatically if you don’t use it for a while. Just turn it back on.

5. View into lens
Again, just forget this exists.
6. Viewscreen/Touchscreen Feature

There are three buttons on the viewscreen.
* Bottom left: Video playback. You might have occasion to use this.
* Bottom right: Sophisticated adjustments available here. As you start out, just
forget this exists.
» Top left: Home key gets you back to main viewscreen if you follow either
button above.
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Here is important information on the viewscreen:
* Top left: Battery life remaining,
* Top middle: In record mode, a green STBY says you’re ready to shoot and a
red REC says you're recording. A counter appears to the right showing the

i
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how fong you've been shooting. -
* Upper right: You’ll see how many minutes of record time you have on the
hard drive. You’ll never fill it.

7. Zoom

Push lever right to zoom in. Push it left to zoom out. You’ll see a guide on the
viewscreen saying how wide or tight you are.

More Involved Camera Stuff

Everything in this section is strictly nice to know. You can accomplish your mission
without using any of it.

Reviewing video: On the viewscreen, hit the play button at lower left. This will bring
up a screen with all of the shots on the Handycam. You create an individual shot each
time you hit record. To watch clips, hit them on the touchscreen. You can use
touchscreen keys to get through the clips. To get back to record mode, either hit the
camcorder icon at lower left or hit the home icon at top left and then hit “Movie.”

Sophisticated settings: Hit the button at lower fight for sophisticated settings such as

white balance, record mode, microphone level. Tabs at the bottom of the screen will
show the options. At this level, being here is more trouble than it’s worth.

Getting Your Video Files Into the Institute’s Server Folder

Follow these steps:

* Plug gray USB cord into camera and into computer’s USB port.

* Tell the camera to talk to the computer.

* Make sure you have established a unique folder on the institute’s server space
for this project.

* Drag and drop the folder with your video files into your folder on the
institute’s server space.

* Disconnect the camera from the computer.

Connect USB Cord to Camera and Computer:
There is a sliding door the side of the camera next to the on/off wheel. Stick the

smaller end of the gray cord in the lower port inside this door. Stick the larger end in
a USB port, which is on the back side of the iMac.



Tell the Camera to Talk to the Computer:

‘When the camera is connected to the computer, the Handycam’s viewscreen will
present some options. For a reason that escapes your instructor, there are two options

saying “USB Connect.” Hit the “USB Connect” on the LEF T AlSo for a Teason that
escapes your instructor, iPhoto might activate on your computer. Just close it. You
can tell the camera is talking to the computer when a drive called “NO NAME”
appears on the desktop, as shown below.

Set Up a Folder on the Institute’s Server Space:

Follow the instructions in the “Using the Cronkite School’s Computers” handout. Just
make sure you have a unique folder set up where you can drop a folder of video files
from the Handycam.

St

View: Show items as icons, in a list, 1n
columns, or with Cover Flow.,
T i

Drag and Drop the Folder With Video Files:

Open the NO NAME drive and drag the entire folder marked AVCHD into the folder
you created on the institute’s server space. It should be the top folder.

AVCHD ‘Mar 24, 2009, 6:19 PM
» B8 AVF_INFO Nov 4, 2008, 3:23 AM .
» (B oam Nov 4, 2008, 8:03 PM --

¥4 MODELCFG.IND Today, 2:11 PM 32 KB



o Disconnect Camera From Computer:

p——

When you are done with the camera, drag the NO NAME folder into the Recycle Bin.
Then it’s fine to unplug the camera.

Getting Your Video Files Into FinalCut

Follow these easy steps:

* Launch FinalCut. Resize some components so you have access to the folder
with the AVCHD folder from folder you set up on the institute’s server space.
Open the Log and Transfer window by hitting File>Log and Transfer.

Drag the AVCHD folder from the institute’s server space into the top left
quadrant of the Log and Transfer window. Your shots will appear as slips, as
shown in the screenshot below.

*  Proceed as you would normally in FinalCut.
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QUICK AND DIRTY FINALCUT PRO INSTRUCTION SHEET

Step One: Set Up a Folder on the Deskiop
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Your entire video project will go in here. The folder eventually will be huge: Trneedsto—

be on the desktop and all project elements need to go in it so you can move it easily to the
instructor’s hard drive for storage. While it’s fine to store video files from the Handycam
on the institute’s shared folder, you may not store FinalCut projects there because they
are big enough to clog the school’s servers. FinalCut projects stored in the institute’s
shared folder will be deleted without warning.

Step Two: Drag AVCHD Folder From Handycam or Institute Shared Folder Into
the Folder You Created

See the handout Using Sony Handycams and Getting Video Into FinalCut.
Step Three: Start FinalCut

Click this icon in the task bar.

Step Three: Drag AVCHD Folder From Handycam or Institute Shared Folder Into
The Folder You Created

~ See the handout Using Sony Handycams and Getting Video Into FinalCut.



Step Four: Set Scratch FinalCut Scratch Disks to Your Folder .

Each time you start FinalCut, you will get the prompt below asking you to set the scratch
disks, which is where all of the files associated with a FinalCut project go. It asks because
video projects are big enough to choke hard drives, and it’s usually a good idea to have
an external hard drive to hold video projects so as to avoid clogging your computer. Hit
Reset Scratch Disks.

At the prompt below, you need to click “Set” and then select you’re the desktop folder
you created for four items in this prompt: the top item, which directs the overall project
someplace (don’t mess with the boxes that have checks); Waveform Cache; Thumbnail
Cache and Autosave Cache. Hit OK.
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Step Five: Create a Project in Final Cut (File>New Project)

It’s a good idea to save the project right away so FinalCut’s autosave function can start
protecting you. Be sure to save the project in the desktop folder you created!

New
New Project 38N
Open... %0
Open Recent >




Step Six: Hit File>Log and Transfer to Import Video Folder

See the handout Using Sony Handycams and Getting Video Into FinalCut.

~ Step Seven: Get to Know the FinalCut Work Area

Don’t worry. It looks complicated, but it makes sense once you go through it once or
twice. You can do very sophisticated things in FinalCut, but you need to know very little
to produce a simple video.

The sections of the FinalCut screen are:

* The Browser (upper left): This is where your clips from the camera and any
photos, music, etc., you want in the project (File>Import) show up. All you need
to know about the Sequence 1 you see at this point is that it represents what’s in
the timeline (explained below).

» Viewer (top middle): The magic happens here. Double click the icon next to an
item in the browser and it will load here. You’ll use the viewer to define
selections from clips that you want to go into the movie. See below for details.

» Canvas (top right): This is a player that shows what you’ve put in your timeline.
You can do some fancier things here, but this is a beginner class so don’t worry
about those.

 Timeline: You’ll arrange video and audio here to make the movie. The video
track goes on top and the audio track goes below. FinalCut has multiple video and
audio tracks, which provides a lot of flexibility in creating projects. More on that
in a bit.

Viewer: You look at clips Canvas: This window
here and decide what ‘ B plays what's in your
will go in your timeline, timeline,

. (see above) go here,

o

Timeline: Video tracks go in this
section.

Timeline: Audio tracks go in this
section (almost always associated |
with video tracks)




Step Eight: Review What’s in Your Browser e

Your clips will be labeled Clip #1, etc., which is almost useless, though the duration of
clips can give you some idea of what’s an interview and what’s B-roll. It might help to

review and name each clip (click the icon left of the hame and play the clip i th
viewer). But it isn’t worth it with a small project. However ...

Without reviewing each clip, you can get a good idea of what’s in them by changing the
view to icons (View>Browser Items>As medium icons).

Step Nine: Let’s Define a Clip .

Double click on the icon next to (or over) the name of the clip to load that clip in the
Viewer (top middle). This is where you will define what from that clip you want in your
movie. There are a lot of options in here, but all you need to know at this point is that the
white line immediately below the clip has a playhead (yellow triangle) that shows where
you’re at in the clip (you can “scrub” through the clip quickly by dragging the playhead
and dragging it right and left). There’s a start/stop button where you’d expect it, and you
might find the go to the start/go to the end buttons helpful. Turn the scroll wheel right and
left to move very slowly through the clip (very helpful when finding the precise point in
interviews where you want the passage to begin and end).

Go Begmman End

Scrol

Playhead Start/Stop slowly
[}
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Step 10: Set In and Out Points in Your Clip

When you identify the point where you want the clip to begin, hit the I key to set an “in”
point. You’ll see a symbol that looks like this >|. When you identify the point where you

want the clip to end, hit the O key to set an “out” point. You will see a symbol that Tooks
like this |<. '

Step 11: Put Your Clip in the Timeline

The timeline (bottom of the screen) has its own playhead. Put the playhead where you
want your clip to appear. You then have two options for getting the clip from the browser
into the timeline: drag it directly into the timeline or drag it into the Canvas window,
where you will see a series of options. Click and hold in the browser and you’ll see that
the mouse has “grabbed” the clip. I recommend dragging the clip directly into the
timeline.

You have two main options when you put a clip into the timeline: the Insert and
Overwrite options, If dragging your clip into the timeline, you’ll see an arrow pointing
either to the right (insert) or down (overwrite). If you use the Insert option, the clip will
break into anything that’s already at that point in the timeline and push everything from
the playhead forward to the right. The overwrite option is more forgiving. Let go of the
mouse button and the clip will be in the timeline. You can move it around with the mouse
once it’s there.

If you see this prompt, just say yes.

I5 does pot match this sequence’s seirings or
nce presets,




Here’s what the timeline should look like with a clip in it. The video portion of the file is
above, and there are two audio tracks below. The video and audio tracks are connected. '
You can work with them independently, but that’s beyond where we’re at.

You can keep adding clips to the right of the one that’s there. The new clip should snap to
the existing one when you’re in the right spot.
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Step 12: Play Your Timeline in the Canvas Window (top right) o
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Put the playhead at the beginning of the timeline and see what you’ve created.
Step 13: Practice Adding a Cutaway Shot

Cutaway shots, or B-roll, can be added very easily in FinalCut because it offers a
seemingly limitless number of video tracks (V1, V2, V3, etc.). Any clip that’s in a video
track above a clip in another video track will play over the video clip below. A cutaway
shot shouldn’t be more than 3-4 seconds. Count one off in the browser and drag it to the
timeline and use the OVERWRITE option to put it in track V2 above a track in V1. You
will see the clip in the V2 track and in audio tracks below the audio associated with the
clip in V1. You move the cutaway shot right and left to get it exactly where you want it.
You can add more cutaway shots the same way. Play what’s in the timeline and yow’ll
see the cutaway shot play over what was there before.

o




Step 14: Adjust the Volume

Any audio tracks in the timeline at the same point will play. With audio associated with
cutaway shots/B-roll, it’s best to lower the audio level (some of that sound is usually

yow’ll see this display in the Browser window. Use the mouse to grab the top pink line
and move it down (you can also move it up if you want to raise the audio level). Click on
the video tab at the top of the browser and you’ll see the video associated with the audio
when you play the timeline.

Step 15: Render Unto Caesar — Or Just Render

If you see a red line right above the timeline, it means you need to render audio or video
in that section. Just execute Sequence>Render Selection>Both. If that doesn’t make the
red line disappear, ask the instructor.

Render Selection

Render All
Render Only b
Settings... 80

Step 15: Export Your Movie

Just trust me on these steps:

e Conversion (NOT QuickTime Movie).

ﬁ;%g; I

QuickTime Movie...

Using Compressor...

Baich Export . . .
o Using QuickTime Convearsion...

Batch Capture...
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2. When prompted, give the movie a name and a destination where you can find it. Make
sure the format says QuickTime. Then hit the Options button to the right of the Format
dropdown.
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Hit the Size button and select Custom from the Dimensions dropdown.

Current
¥ Compressor native

160% 120

176 x 144 QUIF
320 x 240 QVEA
352 x 288 CIF
E49 x 480 VCA
768 x 576 5D
1250 x 720 HO
1520 x 1080 HD

NTSC 720 x 450 4:3
NTSC 720 x 480 16:9
NTSC 720 x 486 413
NTSC 720 x 486 16:9
PAL 720 x 576 4:3
PAL 720 x 576 16:5
HD 1280 x 720 16:9
HD 1440 x 1080 16:9

HD 1520 x 1980 16:9

L peeserve aspect ratio using: - !

* T Dejarerlace Sourcs Video

Hit the Settings button under Sound and use the dropdown to change the Rate to 44.100

from 48.000. Hit OX.

Hit OK to get out of Movie Settings and then Save your movie to start the process of

creating the QuickTime movie.
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